Operation Guide
Sequence Creation Software
SD023-PLZ-5W
Wavy for PLZ-5W
Ver. 5.x
About This Guide

This guide is a PDF version of the SD023-PLZ-5W Wavy for PLZ-5W help file.

Copyrights

The contents of this guide may not be reproduced, in whole or in part, without the prior consent of the copyright holder.

The contents of this guide are subject to change without notice.

Copyright 2016© Kikusui Electronics Corporation

Table of Contents

Introduction ............................................................3
Starting Wavy .........................................................4
Configuring the Interface ........................................5
Using the RS232C interface .....................................................5
Using the GPIB interface...........................................................7
Using the USB interface ............................................................9
Using the LAN interface.........................................................11
Window Explanation ............................................14
Sequence Overview ..............................................15
Programs and steps................................................................. 15
Main features ............................................................................. 16
Flow of sequence execution ................................................ 17
Program Configuration ........................................18
Setting the operation mode, slew rate, and response speed .................................................................................. 18
Setting the current range and voltage range............... 19
Setting the unit of step execution time (interval) ........ 20
Setting the constant voltage mode addition (+CV) .... 21
Setting the number of times the program will repeat22
Turning off the load at the end of sequences................ 23
Protection Functions ............................................24
PLZ-5W's protection functions (hardware settings).... 24
Wavy protection functions (Soft Setting)........................ 26
Creating and editing steps by drawing graphs..27
Creating steps.................................................................27
Editing steps .................................................................28
Creating and editing steps by entering values ..31
Creating steps.................................................................31
Copying and deleting steps ................................................. 33
Saving and Loading Sequences ..............................35
Saving a sequence ............................................................. 35
Loading a sequence .......................................................... 36
Executing sequences ........................................... 37
Writing a sequence in the PLZ-5W .................................... 37
Loading a PLZ-5W sequence ........................................... 38
Executing, aborting, and pausing sequences .......... 39
Configuring the Monitor ............................................41
Showing or hiding current, voltage, and power values.. 41
Setting the monitoring interval........................................ 42
Saving monitored data ...................................................... 44
Setting the Graph Display ............................................46
Setting the scale display.................................................. 47
Setting line colors and background color..................... 48
Showing and hiding the step-division lines (vertical ax-

...is).......................................................................................... 49
Setting the graph scale....................................................... 49
Setting the load line display .............................................. 51
Setting the Y value display .............................................. 51
Setting the unit of the X-axis ........................................... 52
Setting the Window Display ..................................... 53
Setting the toolbar and status bar ................................ 53
Setting the load line display .............................................. 53
Other settings ............................................................. 54
Reducing the PC load ...................................................... 54
Setting the file format for saving data ....................... 54
Copying graph images to the clipboard ...................... 55
Setting whether to display the sequence that was
showing when Wavy was closed previously ......... 55
Controlling the PLZ-5W ....................................... 56
Controlling the PLZ-5W directly......................................... 56
Using commands to control the PLZ-5W................. 61
Menu Reference ....................................................62

About This Guide

This guide is a PDF version of the SD023-PLZ-5W Wavy for PLZ-5W help file.

Copyrights

The contents of this guide may not be reproduced, in whole or in part, without the prior consent of the copyright holder.

The contents of this guide are subject to change without notice.

Copyright 2016© Kikusui Electronics Corporation

Table of Contents

Introduction ............................................................3
Starting Wavy .........................................................4
Configuring the Interface ........................................5
Using the RS232C interface .....................................................5
Using the GPIB interface...........................................................7
Using the USB interface ............................................................9
Using the LAN interface.........................................................11
Window Explanation ............................................14
Sequence Overview ..............................................15
Programs and steps................................................................. 15
Main features ............................................................................. 16
Flow of sequence execution ................................................ 17
Program Configuration ........................................18
Setting the operation mode, slew rate, and response speed .................................................................................. 18
Setting the current range and voltage range............... 19
Setting the unit of step execution time (interval) ........ 20
Setting the constant voltage mode addition (+CV) .... 21
Setting the number of times the program will repeat22
Turning off the load at the end of sequences................ 23
Protection Functions ............................................24
PLZ-5W's protection functions (hardware settings).... 24
Wavy protection functions (Soft Setting)........................ 26
Creating and editing steps by drawing graphs..27
Creating steps.................................................................27
Editing steps .................................................................28
Creating and editing steps by entering values ..31
Creating steps.................................................................31
Copying and deleting steps ................................................. 33
Saving and Loading Sequences ..............................35
Saving a sequence ............................................................. 35
Loading a sequence .......................................................... 36
Executing sequences ........................................... 37
Writing a sequence in the PLZ-5W .................................... 37
Loading a PLZ-5W sequence ........................................... 38
Executing, aborting, and pausing sequences .......... 39
Configuring the Monitor ............................................41
Showing or hiding current, voltage, and power values.. 41
Setting the monitoring interval........................................ 42
Saving monitored data ...................................................... 44
Setting the Graph Display ............................................46
Setting the scale display.................................................. 47
Setting line colors and background color..................... 48
Showing and hiding the step-division lines (vertical ax-

...is).......................................................................................... 49
Setting the graph scale....................................................... 49
Setting the load line display .............................................. 51
Setting the Y value display .............................................. 51
Setting the unit of the X-axis ........................................... 52
Setting the Window Display ..................................... 53
Setting the toolbar and status bar ................................ 53
Setting the load line display .............................................. 53
Other settings ............................................................. 54
Reducing the PC load ...................................................... 54
Setting the file format for saving data ....................... 54
Copying graph images to the clipboard ...................... 55
Setting whether to display the sequence that was
showing when Wavy was closed previously ......... 55
Controlling the PLZ-5W ....................................... 56
Controlling the PLZ-5W directly......................................... 56
Using commands to control the PLZ-5W................. 61
Menu Reference ....................................................62
Introduction

Sequence Creation and Control Software SD023-PLZ-5W Wavy for PLZ-5W is a software application that is used to create and execute sequences on PLZ-5W series electronic loads. This operation guide explains how to use SD023-PLZ-5W Wavy for PLZ-5W to control the PLZ-5W.

- **Product versions that this guide covers**
  
  This operation guide applies to version 5.x of SD023-PLZ-5W Wavy for PLZ-5W. To check the version, on the Help menu, click About Wavy.

- **Who should read this guide?**
  
  This operation guide is intended for users who will use SD023-PLZ-5W Wavy for PLZ-5W to control the PLZ-5W and instructors of such users. Explanations are given under the presumption that the reader has knowledge of power supplies.

- **Trademarks**
  
  Microsoft and Windows are trademarks of Microsoft Corporation in the United States and/or other countries.
  
  All other company and product names used in this guide are trademarks or registered trademarks of their respective owners.

- **Notations used in this manual**
  
  - In this guide, Sequence Creation Software SD023-PLZ-5W Wavy for PLZ-5W is referred to as “Wavy.”
  
  - The PLZ-5W Series Electronic Load is also referred to as the PLZ-5W.
  
  - The term “PC” is used to refer generally to both personal computers and workstations.
  
  - The screens used in this manual may differ from the actual items.
  
  - The following markings are used in this guide.

  **NOTE** Indicates information that you should know.

  **>** Indicates the menu command you need to select. The menu command to the left of “>” is the higher level command.
To start Wavy, on the Windows taskbar, click Start, All Programs, Kikusui, SD023-PLZ-5W, and then Wavy for PLZ-5W.
Configuring the Interface

Connect the PLZ-5W to a PC in which Wavy is installed, and configure the Wavy interface.

Using the RS232C interface

- Configuring the PLZ-5W
  1. Turn on the PLZ-5W’s POWER switch.
  2. Turn the load off on the PLZ-5W.
  3. Press SYSTEM and then Interface.
     The Interface screen appears. If the Configure screen appears, press Interface again. The Interface and Configure screens toggle each time you press the key.
  4. Press Modify.
     You can now edit the interface settings.
  5. Use the rotary knob to select Bitrate under RS232C Settings, and then press Edit.
  6. Use the rotary knob to select the bit rate, and then press ENTER.
  7. Use the rotary knob to select Flow Control under RS232C Settings, and then press Edit.
  8. Use the rotary knob to select CTS-RTS, and then press ENTER.
  9. Press Apply, use the rotary knob to select OK, and then press ENTER.
     This completes the settings.
 10. Connect the PLZ-5W and PC with a RS232C cable.

- Configuring Wavy
  1. Start Wavy.
2 **On the Sequence menu, click Interface.**
   The Interface window appears.

![Interface Window](image)

3 **In the Instrument list, click the model name of the connected PLZ-5W.**

4 **Click RS232C.**

5 **In the Port list, click the COM port number that the PLZ-5W is using.**
   To check the port number, from Windows Control Panel, open Device Manager. Expand Port (COM & LPT) to view the port number in use.

6 **In the Baud rate list, click the same value as the Bitrate setting on the PLZ-5W.**

7 **Click Test to check that Wavy can communicate with the PLZ-5W.**
   Protocol settings other than baudrate and flow control are fixed on the PLZ-5W. They are set as follows:
   - Data bits: 8 bits
   - Stop bits: 1 bit
   - Parity bit: none
   Wavy exchanges data according to the above protocol settings. There is no need to manually change them on the PC side.

8 **Click OK.**
   This completes the settings.
Using the GPIB interface

**NOTE:** To use GPIB, you need a GPIB converter (PIA5100 firmware version 1.01 or later) sold separately. For details, see the GPIB converter manual contained in the CD-ROM included with the PLZ-5W.

- **Configuring the PLZ-5W**
  1. Turn on the PLZ-5W’s POWER switch.
  2. Turn the load off on the PLZ-5W.
  3. Connect the PC and PLZ-5W through the GPIB converter.
  4. Refer to the GPIB converter manual, and configure the necessary settings.

- **Configuring Wavy**
  1. Start Wavy.
  2. **On the Sequence menu, click Interface.**
     The Interface window appears.
     ![Interface Window](image.png)
     3. In the Instrument list, click the model name of the connected PLZ-5W.
     4. Select GPIB.
     5. In the Address list, click the GPIB address that you assigned with the GPIB converter.
     6. **Click Test to check that Wavy can communicate with the PLZ-5W.**
        If it fails to connect, see “If connection fails using GPIB” (p.8).
     7. Click OK.
        This completes the settings.
If connection fails using GPIB

With the VISA library, set the GPIB board number to 0. The following procedure is for when KI-VISA is used for the VISA library. If you are using another VISA library, see the corresponding manual.

1. On the task bar, click Start, All Programs, Kikusui IO Software, KI-VISA, and then Instrument Explorer.
   Instrument Explorer will start.
   If “Instrument Explorer” is not displayed in the Start menu or the desktop, open KiVisaExp.exe in the following folder.
   64 bit OS: `C:\Program Files\IVI Foundation\VISA\VisaCom64\KiVisa`
   32 bit OS: `C:\Program Files\IVI Foundation\VISA\VisaCom\KiVisa`

2. Click KI-VISA IO Config.

3. Click the GPIB (NI-488.2) tab.

4. In the Index list, click GPIB0.

5. Click OK.
   The KI-VISA IO Config window closes. Execute the GPIB connection test (p.7) again.
Using the USB interface

To use the USB interface to control the PLZ-5W, a device driver that supports the USB T&M class (USBTMC) must be installed on the controller. The USBTMC driver is installed automatically by the VISA library. For details on installing the VISA library, see the included setup guide.

- **Configuring the PLZ-5W**
  1. Turn on the PLZ-5W’s POWER switch.
  2. Turn the load off on the PLZ-5W.
  3. Connect the PLZ-5W and PC with a USB cable.

- **Configuring Wavy**
  1. Start Wavy.
  2. On the Sequence menu, click Interface.
     The Interface window appears.

     ![Interface Window]

     In the Instrument list, click the model name of the connected PLZ-5W.

     Select USB.
5 **In the Serial Number list, select the serial number of the PLZ-5W.**
For the location of the serial number, see the PLZ-5W Operation Manual.
If the serial number does not appear even when the PC and PLZ-5W are connected properly,
from Windows Control Panel, open Device Manager, and check whether “USB Test and Mea-
surement Device” is displayed. If it is not displayed, reinstall the VISA library.

6 **Click Test to check that Wavy can communicate with the PLZ-5W.**

7 **Click OK.**
This completes the settings.
Using the LAN interface

- **Configuring the PLZ-5W**
  1. Turn on the PLZ-5W’s POWER switch.
  2. Turn the load off on the PLZ-5W.
  3. Connect the PLZ-5W and PC with a LAN cable.

- **Configuring Wavy**
  1. Start Wavy.
  2. On the Sequence menu, click Interface. The Interface window appears.
  3. In the Instrument list, click the model name of the connected PLZ-5W.
  4. Click LAN.
  5. In the IP address list, click the IP address of the connected PLZ-5W.
     If the IP address is not displayed even when the PLZ-5W is connected properly, you need to search for the device connected through LAN using the VISA library (p.12).
  6. Click Test to check that Wavy can communicate with the PLZ-5W.
  7. Click OK.
     This completes the settings.
If the PLZ-5W is no longer recognized

If a fixed IP address is not assigned to the PLZ-5W, the IP address may change, causing the PC to no longer recognize it. If this occurs, check the IP address on the PLZ-5W device information screen (press SYSTEM and then Information), and then set the IP address again on Wavy.

Searching for the device connected through LAN

The following procedure is for when KI-VISA is used for the VISA library. If you are using another VISA library, see the corresponding manual.

1 On the task bar, click Start, All Programs, Kikusui IO Software, KI-VISA, and then Instrument Explorer.

   Instrument Explorer will start.
   If “Instrument Explorer” is not displayed in the Start menu or the desktop, open KiVisaExp.exe in the following folder.
   64 bit OS: C:\Program Files\IVI Foundation\VISA\VisaCom64\KiVisa
   32 bit OS: C:\Program Files\IVI Foundation\VISA\VisaCom\KiVisa

2 Click KI-VISA IO Config.

3 Click the LAN tab.
4 Select the Enable dynamic search for active instruments check box.

5 Click OK.
The KI-VISA IO Config window opens.

6 Check that the IP address of the connected PLZ-5W appears in the tree on the left side of the Instrument Explorer window, and close Instrument Explorer.

You can now select the IP address in the Wavy’s Interface window.
When you start Wavy (p.4), the sequence setup windows appear.

In the Graph window, you can create steps by drawing a graph with the mouse (p.27). In the Worksheet window, you can edit steps by entering values and conditions (p.31). The status bar shows the following information.

- Series name
- Model name
- Operation mode
- Connection mode
- Unit of step time interval
Sequence Overview

Sequence is a function that executes a sequence of operations set in advance. It consists of programs and steps. There are settings for each program and settings for each step that you need to specify.

Programs and steps

A program is a collection of steps. Steps are executed in order one at a time, starting from step 1. When the last step of a program is complete, the execution of that program will have been completed once.

Set a program for each operation mode. Up to 30 programs can be set.

Up to 10000 steps total can be used in all programs.
Main features

**Sequence Overview**

**Main features**

- **Load value transition method**
  
The available load value transition methods are step (Immediate) and ramp. With step, the load value transitions step-wise from the value of the previous step. With ramp, the load value transitions in a ramp from the value of the previous step.

**Example when the value is 10 A and the interval 1 s**

- **Step**
  
  - Value: 10 A
  - Time: 1 s

- **Ramp**
  
  - Value: 10 A
  - Time: 1 s

**NOTE**

If step 1 is set to ramp transition, the start point of the load value is always 0 A, 0 S, 0 V, 0 W.

---

<table>
<thead>
<tr>
<th>Scope</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Operation mode</td>
<td>Operation mode for executing sequences.</td>
</tr>
<tr>
<td></td>
<td>Slew rate</td>
<td>Default step slew rate.</td>
</tr>
<tr>
<td></td>
<td>Response speed</td>
<td>Response speed in constant resistance (CR) mode and constant voltage (CV) mode.</td>
</tr>
<tr>
<td></td>
<td>Current/voltage range</td>
<td>Current range and voltage range for executing sequences.</td>
</tr>
<tr>
<td></td>
<td>Repetition count</td>
<td>Number of times that the program will repeat.</td>
</tr>
<tr>
<td></td>
<td>+CV option</td>
<td>Voltage for the CV mode addition (+CV).</td>
</tr>
<tr>
<td></td>
<td>Protection functions</td>
<td>Overcurrent protection (OCP), overpower protection (OPP).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value for activating undervoltage protection (UVP).</td>
</tr>
<tr>
<td>For each step</td>
<td>Load settings (current, conductance, voltage, power)</td>
<td>Load values of each operation mode. The values that can be set depend on the operation mode.</td>
</tr>
<tr>
<td></td>
<td>Interval</td>
<td>Step execution time.</td>
</tr>
<tr>
<td></td>
<td>Transition</td>
<td>Load value transition method.</td>
</tr>
<tr>
<td></td>
<td>Trigger wait</td>
<td>Trigger signal input on/off.</td>
</tr>
<tr>
<td></td>
<td>Trigger Out</td>
<td>Trigger signal output on/off.</td>
</tr>
<tr>
<td></td>
<td>Load</td>
<td>Load on/off control.</td>
</tr>
<tr>
<td></td>
<td>Slew rate</td>
<td>Slew rate during step execution.</td>
</tr>
</tbody>
</table>

---
Flow of sequence execution

The basic flow of sequence execution is shown below.

Set the operating conditions of the program.
- Setting the operation mode, slew rate, and response speed
- Setting the current range and voltage range
- Setting the number of times the program will repeat
- Protection Functions

Set the operating conditions of the steps.
- Creating and editing steps by drawing graphs
- Creating and editing steps by entering values
- Saving and Loading Sequences

Write and run the sequence.
- Writing a sequence in the PLZ-SW
- Saving monitored data
- Executing, aborting, and pausing sequences
Program Configuration

Set the operating conditions that apply to all steps. Make sure to set the operation mode, slew rate, response speed (p.18), current range, voltage range (p.19), and protection functions (p.24).

Setting the operation mode, slew rate, and response speed

Set the operation mode, slew rate, and response speed for executing sequences. You cannot change the operation mode when a step is entered in the Graph window or Worksheet window, so set the mode when there is no entered steps.

1. **On the Sequence menu, click Sequence Creation Mode. Or, click ** on the toolbar.**
   
   The Sequence Creation Mode window appears.

2. **Set the operation mode, slew rate, and response speed for executing sequences.**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant Current</td>
<td>The operation mode is set to constant current. Enter the default step slew rate for step execution. You can change the slew rate for each step when a step is created.</td>
</tr>
<tr>
<td>Constant Resistance</td>
<td>The operation mode is set to constant resistance. Set the response speed to Normal or Fast.</td>
</tr>
<tr>
<td>Constant Voltage</td>
<td>The operation mode is set to constant voltage. Set the response speed to Normal or Fast.</td>
</tr>
<tr>
<td>Constant Power</td>
<td>The operation mode is set to constant power.</td>
</tr>
</tbody>
</table>

3. **Click OK.**
   
   This completes the settings.
Setting the current range and voltage range

Set the current range and voltage range for executing sequences.

1. **On the Sequence menu, click Sequence Creation Mode. Or, click on the toolbar.**
   
   The Sequence Creation Mode window appears.

   ![Sequence Creation Mode Window]

   Even during parallel operation, only the master unit’s current range is displayed under Current Range.

2. **Select the current range and voltage range for executing sequences.**

3. **Click OK.**
   
   This completes the settings.
Setting the unit of step execution time (interval)

You can set the unit of the step execution time to use when creating steps.
You cannot change the step execution time when a step is entered in the Graph window or Worksheet window, so set the time when there is no entered steps.

<table>
<thead>
<tr>
<th>Unit</th>
<th>Interval setting range</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>ms (milliseconds)</td>
<td>0.025 ms to 9999999.999 ms</td>
<td>0.001 ms</td>
</tr>
<tr>
<td>s (seconds)</td>
<td>0.001 s to 999999.999 s</td>
<td>0.001 s</td>
</tr>
<tr>
<td>min (minutes)</td>
<td>0.1 min to 999.9 min</td>
<td>0.1 min</td>
</tr>
<tr>
<td>h (hours)</td>
<td>0.1 h to 1000.0 h</td>
<td>0.1 h</td>
</tr>
</tbody>
</table>

1. **On the Sequence menu, click Sequence Creation Mode. Or, click \(\text{\textbullet}\) on the toolbar.**
   The Sequence Creation Mode window appears.

2. **In the Unit list, set the unit of step execution time to ms, s, min, or h.**

3. **Click OK.**
   This completes the settings.
Setting the constant voltage mode addition (+CV)

Set whether to add constant voltage mode (+CV) to constant current mode or constant resistance mode.

1. **On the Sequence menu, click Sequence Creation Mode. Or, click 🔄 on the toolbar.**
   The Sequence Creation Mode window appears.

2. **To enable +CV, select the +CV Option check box, and enter the voltage. To disable +CV, clear the check box.**

3. **Click OK.**
   This completes the settings.
Setting the number of times the program will repeat

Set how many times to repeat the program when the sequence is executed.

1. **On the Sequence menu, click Transfer. Or, click on the toolbar.**
The Transfer window appears.

2. In the Repetition Count box, enter the number of times that the program will repeat. If you want to repeat it infinitely, select the Infinity check box.

3. Click Close to close the window.
Turning off the load at the end of sequences

Set whether to turn the load off when sequences finish.

1. **On the Sequence menu, click Transfer. Or, click \( \text{} \) on the toolbar.**
The Transfer window appears.

2. **To turn the load off when sequences finish, select the Load OFF after Completion of Processing check box.** To retain the value of the last step of sequences, clear the check box.

3. **Click Close to close the window.**
You can use the protection functions available on the PLZ-5W (hardware settings) and those available on Wavy (software settings).

- **Hardware settings**
  Hardware settings are protection (alarm) functions available on the PLZ-5W. You can set overcurrent protection (OCP), overpower protection (OVP), undervoltage protection (UVP), and watchdog protection.

- **Software settings**
  These protection functions are activated by Wavy according to judgments made on the monitored data. You can set overvoltage protection (OVP), overcurrent protection (OCP), undervoltage protection (UVP), and Undercurrent protection (UCP).

**PLZ-5W’s protection functions (hardware settings)**

Set the PLZ-5W protection functions.

<table>
<thead>
<tr>
<th>Name</th>
<th>Alarm generation condition</th>
<th>When activated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overcurrent protection (OCP)</td>
<td>Current at or exceeding the OCP value flowed.</td>
<td>Select load off or limit.</td>
</tr>
<tr>
<td>Overpower protection (OPP)</td>
<td>Power at or exceeding the OPP value was applied.</td>
<td>Select load off or limit.</td>
</tr>
<tr>
<td>Undervoltage protection (UVP)</td>
<td>The voltage fell below the UVP value.</td>
<td>Load off</td>
</tr>
<tr>
<td>Watchdog protection</td>
<td>During sequence execution or during direct control monitoring, no communication occurred for 5 seconds or longer.</td>
<td>Load off</td>
</tr>
</tbody>
</table>

1. **On the Sequence menu, click Protection Setup.**
   The Protection Setup window appears.
2 **Click Read.**
The values are read from the connected PLZ-5W.

3 **If necessary, change the protection function values.**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OCP</td>
<td>Enter the OCP value (0% to 110% of the rated current). To turn the load off when alarms occur, select the Load Off check box. To keep the load turned on and control the current so that the OCP value is not exceeded, clear the check box.</td>
</tr>
<tr>
<td>OPP</td>
<td>Enter the OPP value (0% to 110% of the rated power). To turn the load off when alarms occur, select the Load Off check box. To keep the load turned on and control the current so that the OPP value is not exceeded, clear the check box.</td>
</tr>
<tr>
<td>UVP</td>
<td>To enable UVP, select the Enable check box, and enter the value (0 V to 150 V). To disable it, clear the check box.</td>
</tr>
<tr>
<td>WDOG</td>
<td>To enable watchdog protection, select the check box. When enabled, the watchdog protection time value (delay) is set to 5 seconds. To disable it, clear the check box.</td>
</tr>
</tbody>
</table>

4 **Click Set.**
The values are sent to the PLZ-5W and applied to the protection settings for direct control (p.56) and command control (p.61).
Just clicking Set does not apply them to the protection settings of each sequence. To apply them to the protection settings a sequence, write the sequence in the PLZ-5W (p.37).

5 **Click OK.**
This completes the settings.
Wavy protection functions (Soft Setting)

If you set overvoltage protection (OVP) or overcurrent protection (OCP), a sequence stops when a Wavy's monitored value exceeds the set value. If you set undervoltage protection (UVP) or undercurrent protection (UCP), a sequence stops when a Wavy's monitored value falls below the set value.

1. **On the Sequence menu, click Protection Setup.**
   The Protection Setup window appears.

2. **Select the check box for the protection function that you want to set.**
   The text box for entering the protection value is enabled.

3. **Enter the value in the text box.**
   Even when you enter a value, if you clear the check box, the protection function will be disabled. The maximum values that you can enter do not depend on the rated output of the connected PLZ-5W.

4. **Click OK.**
   This completes the settings.

**Ignoring the first monitored values**

As the first monitored values are unstable, they may activate a protection function and stop a sequence. If you select the “Ignore the first monitored value” check box, a sequence will continue its execution even when the first monitored values exceed or fall below the protection values.
Creating and editing steps by drawing graphs

You can create and edit steps by drawing graphs with the mouse.
You can also create and edit steps by entering values (p.31).

Creating steps

This section explains how to create a step in the Graph window.

1. **Move the mouse pointer over the Y-axis.**
   The pointer becomes a cross-hair.
   In constant voltage mode, the voltage is displayed. In constant current mode, the current is displayed.

2. **Drag the pointer to the time and the current or voltage that you want to set.**
   The setting is confirmed, the step-division line is displayed, and the step values are entered in the first row of the worksheet.
   You can change the unit of step interval (p.20) and graph scale (p.49).
   This completes the creation of step 1.
3 If you want to continue creating steps, move the mouse pointer over the end point of the step that you have just created. When the mouse pointer becomes a crosshair, drag the mouse pointer to the point that corresponds to the time and the current or voltage that you want to set.

The value is confirmed, and the step values are entered in the first blank row of the Worksheet window.

Repeat this procedure until you have set all the steps.

Updating the graph scale

To change the X-axis and Y-axis scales according to the graph that you drew, on the Graph menu, click Update Auto Scale, or right-click in the Graph window, and click Update Auto Scale.

Setting the resolution for drawing graphs

You can set the time interval (X-axis) resolution and the value (Y-axis) resolution.

1 Right-click in the Graph window, or click the Graph menu.

2 Click Time interval resolution or Setting resolution, and select the resolution.

<table>
<thead>
<tr>
<th>Time interval resolution</th>
<th>Select Default, 1st digit of integer, 1st digit of decimal place, or 2nd digit of decimal place. The default is three decimal places.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting resolution</td>
<td>Select Default, 1st digit of integer, 1st digit of decimal place, 2nd digit of decimal place, or 3rd digit of decimal place. The default is four decimal places.</td>
</tr>
</tbody>
</table>

Editing steps

Changing the set voltage or current

1 Double-click the line of the step that you want to edit.

A black square is displayed at the step’s end point, and you can edit the step.

2 Move the mouse pointer over the black square.

The pointer changes to a double arrow.

3 Drag the pointer up or down to the value that you want to change to.

The value changes accordingly.
Changing the interval (step execution time)

1. **Double-click the vertical line (the step-division line) at the end point of the step that you want to edit.**
   
   A black square is displayed at the top of the step-division line, and you can edit the step.

2. **Move the pointer over the black square.**
   
   The pointer changes to a double arrow.

3. **Drag the pointer left or right to the value that you want to change to.**

   The value changes accordingly.
Creating and editing steps by drawing graphs

Changing the value transition method
Set the load value transition method between steps(p.16).

1. Double-click the line of the step that you want to change.
   A black square is displayed at the step’s end point, and you can edit the step.

2. On the Graph menu, click Transition. Or, right-click, and click Transition.

3. Click Ramp or Step.
   This completes the settings.

Fixing the value transition method to step
If you want the transition method to always be step when drawing graphs, on the Graph menu,
click Always draw as steps. Or, right-click in the Graph window, and click Always draw as steps.

Deleting a step

1. Double-click the line of the step that you want to delete.
   A black square is displayed at the step’s end point, and you can edit the step.

2. On the Graph menu, click Delete. Or, right-click in the Graph window, and click Delete.
   The step is deleted.
Creating and editing steps by entering values

You can create steps by entering values in tables. You can also copy and delete steps using tables. You can also create and edit steps by drawing graphs (p.27).

Creating steps

This section will explain how to create a step in the Worksheet window.

Enter step data in order, starting from step 1. To edit a load value (current, conductance, voltage, power), interval, or slew rate, click the relevant cell and enter a value. To edit the transition, trigger wait, trigger OUT, or load, double-click the relevant cell. Or click the cell, and press Enter. You can cancel the entering or editing of a cell by pressing Esc.
Description of each item is provided below.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>Total elapsed time from step 1. You cannot change this value.</td>
</tr>
<tr>
<td>Load values</td>
<td>Load values of each operation mode. The values that you can set depend on the specified operation mode.</td>
</tr>
<tr>
<td>Current, conductance, voltage, power</td>
<td></td>
</tr>
<tr>
<td>Interval</td>
<td>Step execution time. The values that you can set depend on the unit of step time interval (p.20).</td>
</tr>
<tr>
<td>Transition</td>
<td>Load value transition method. Step or ramp.</td>
</tr>
<tr>
<td>Trigger Wait*1</td>
<td>Trigger signal input. BUS or off.</td>
</tr>
<tr>
<td></td>
<td>If you set this to BUS, the sequence pauses at the end of the step. When you click Continue in the Wavy sequence run window or when you enter a *TRG command from a PC or the like, the pause is released.</td>
</tr>
<tr>
<td>Trigger OUT*1</td>
<td>Trigger signal output. On or off.</td>
</tr>
<tr>
<td></td>
<td>If set to on, a 10 μs trigger signal is transmitted from the PLZ-SW's TRIG OUT connector at the start of step execution.</td>
</tr>
<tr>
<td>Load</td>
<td>Load on/off control. On or off.</td>
</tr>
<tr>
<td>Slew Rate</td>
<td>Slew rate during step execution.</td>
</tr>
<tr>
<td></td>
<td>The range of values depends on the current range setting.</td>
</tr>
</tbody>
</table>

*1. For details on trigger signal input/output, see the user's manual contained in the PLZ-SW's accompanying CD-ROM.
Creating and editing steps by entering values

Copy steps by entering values

Copying and deleting steps

You can use the Worksheet window to copy and delete the steps you have created.

Copying and inserting steps

1. Click a cell in the step (row) that you want to copy.
   You can click any cell in the step.
   You can select consecutive steps by holding down the Shift key.

2. On the Worksheet menu, click Copy. Or, right-click in the Worksheet window, and click Copy.

3. Click OK.

4. Click a cell of the appropriate step.

5. On the Worksheet menu, click Paste. Or, right-click in the Worksheet window, and click Paste.

6. Click Yes.
   The copied step is inserted before the selected step, and the total number of steps increases by 1.

Deleting steps

You can delete steps (rows). You cannot delete the content of cells individually.

1. Click a cell in the step (row) that you want to delete.
   You can click any cell in the step.
   You can select consecutive steps by holding down the Shift key.

2. On the Worksheet menu, click Delete. Or, right-click, and then click Delete.

3. Click Yes.
   The step is deleted.

Deleted steps are copied to the clipboard. If you insert a step immediately after deleting steps, the deleted steps will be inserted.

Undoing the copying and deleting steps

You can undo the last copying or deleting of steps by clicking Undo on the Worksheet menu, or right-clicking the Worksheet window and clicking Undo.
## Keyboard shortcuts

You can use keyboard shortcuts in the Worksheet window.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Shortcut keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy steps</td>
<td>C or Ctrl+C</td>
</tr>
<tr>
<td>Insert steps*¹</td>
<td>V or Ctrl+V</td>
</tr>
<tr>
<td>Delete steps*¹</td>
<td>Delete</td>
</tr>
<tr>
<td>Undo*¹</td>
<td>Z or Ctrl+Z</td>
</tr>
<tr>
<td>Select all rows</td>
<td>A or Ctrl+A</td>
</tr>
</tbody>
</table>

*¹ A confirmation dialog appears before execution.
Saving and Loading Sequences

After you set the program and steps, save the sequence. You can also load saved sequences.

Saving a sequence

To save as a new sequence, on the File menu, click Save As.

To overwrite a file, on the File menu, click Save. Or, click on the toolbar. The file name extension is “.wvy.” If you select Save when there are no saved sequences, the Save As dialog box will open.

 Editing a saved sequence with a text editor

You can edit saved sequence data using Notepad or other text editor.

<table>
<thead>
<tr>
<th>Column 1</th>
<th>Operation mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CC: constant current mode, CR: constant resistance mode, CV: constant voltage mode, CP: constant power mode</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column 2</th>
<th>Unit of step time interval</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ms: milliseconds, s: seconds, min: minutes, h: hours</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column 3</th>
<th>Voltage range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>H: H range, M: M range, L: L range</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column 4</th>
<th>Current range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>H: H range, M: M range, L: L range</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column 5</th>
<th>Slew rate (default value) [A/μs]</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Column 6</th>
<th>+CV</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0: off, 1: on</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column 7</th>
<th>+CV value [V]</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Column 8</th>
<th>OCP value [A]</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Column 9</th>
<th>Operation at OCP activation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0: limit, 1: load off</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column 10</th>
<th>OPP value [W]</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Column 11</th>
<th>Operation at OPP activation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0: limit, 1: load off</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column 12</th>
<th>UVP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0: off, 1: on</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column 13</th>
<th>UVP value [V]</th>
</tr>
</thead>
</table>

NOTE: When editing sequence data, do not change the case of letters. If you do, the sequence will no longer work.

- By default, data is saved as tab-separated values. Data can also be saved as comma-separated values (p.55).
- The first row shows the PLZ-5W series name.
- The second row shows the following items.
Saving and Loading Sequences

- The subsequent rows show the following items.

<table>
<thead>
<tr>
<th>Column 1</th>
<th>Load value</th>
<th>[A], [S], [V], [W]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column 2</td>
<td>Step time interval</td>
<td>The unit is shown in row 2.</td>
</tr>
<tr>
<td>Column 3</td>
<td>Transition</td>
<td>0: Step, 1: Ramp</td>
</tr>
<tr>
<td>Column 4</td>
<td>Trigger Wait</td>
<td>0: off, 1: BUS</td>
</tr>
<tr>
<td>Column 5</td>
<td>Trigger Out</td>
<td>0: off, 1: on</td>
</tr>
<tr>
<td>Column 6</td>
<td>Load</td>
<td>0: off, 1: on</td>
</tr>
<tr>
<td>Column 7</td>
<td>Slew rate [A/μs]</td>
<td></td>
</tr>
</tbody>
</table>

## Loading a sequence

You can load and use saved sequences.

To open the file you want to load, on the File menu, click Open. Or, click on the toolbar.
Executing sequences

Sequences that you create are written in the PLZ-5W to be executed. It is also possible to load sequences from the PLZ-5W into Wavy.

Writing a sequence in the PLZ-5W

This section describes how to write (transfer) sequences that you create in the PLZ-5W. The following settings are also transferred along with the sequence.

- Repetition Count
- Load OFF after Completion of Processing

1. **On the Sequence menu, click Transfer. Or, click 🔄 on the toolbar.**
   The Transfer window appears.

2. **Under Write, set the following items.**
   - **Program name**
     To overwrite a program that you created on the PLZ-5W, select the name from the list. To write a new program, select the box under the list, and enter a file name using up to 255 characters.
   - **Erase All Programs**
     Select this check box to erase all programs stored in the PLZ-5W first and then transfer the file. The programs that are deleted are those that correspond to the operation mode of the program to be transferred.

3. **Under Setting, set the following items.**
   - **Repetition Count**
     Set the number of times that the program will repeat. If you want to repeat it infinitely, select the Infinity check box.
   - **Load OFF after Completion of Processing**
     Select this check box to turn the load off when sequences finish. To retain the value of the last step of sequences, clear the check box.

4. **Under Write, click Run.**
   Transferring starts. The progress of the data transfer is displayed as a progress bar. If there are a large number of steps, it may take up to about 3 minutes.

5. **When the data transfer is complete, click Close.**
Loading a PLZ-5W sequence

It is possible to load sequences from the PLZ-5W into Wavy. You can use this function to back up sequences that you create on the PLZ-5W or to edit them.

NOTE: The number of programs that can be loaded is 30. Loading more than 30 programs may make the Wavy operation unstable.

1. **On the Sequence menu, click Transfer. Or, click on the toolbar.**
   The Transfer window appears.

2. **Under Read, select the name of the program from the Program name list.**

3. **Click Run under Read.**
   Loading starts. If there are a large number of steps, it may take up to about 3 minutes.

4. **When the data transfer is complete, click Close.**
Executing, aborting, and pausing sequences

**NOTE:**
- If you created the sequence on Wavy, write the sequence in the PLZ-5W (p.37) before executing it. If you do not write the sequence first, the sequence selected on the PLZ-5W will be executed.
- If you want to save the monitored data during sequence execution, specify the monitored data save setting in advance (p.44).

1. **On the Sequence menu, click Run. Or, click on the toolbar.**
   The Run window appears.
   ![Run window](image)
   If you selected the “Display the monitor graph” check box in Monitoring Setup (p.42), the Monitor Graph tab appears. In Monitor Graph, you can view in real time the voltage, current, and power values during sequence execution.

2. **Click Run.**
   The sequence is executed.
   To abort a sequence, click Stop.
   To pause a sequence, click Pause. While a sequence is paused, clicking Continue will release the pause.
   ![Status indicator](image)
   The approximate position of execution (green line)
   During test execution, the menus and the toolbar are disabled. Further, the window cannot be resized.
Executing sequences

Display during sequence execution

The following items are displayed during sequence execution.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green line</td>
<td>The approximate position of execution. For sequences that have a large number of repetitions or those that take a long time to run, the position indicated by the green line may appear offset from the actual position.</td>
</tr>
<tr>
<td>Program</td>
<td>The number of the program that is being executed.</td>
</tr>
<tr>
<td>Count</td>
<td>The present repetition count.</td>
</tr>
<tr>
<td>Step</td>
<td>The step that is currently being executed.</td>
</tr>
<tr>
<td>Elapsed Time</td>
<td>The elapsed time since the start of sequence execution.</td>
</tr>
<tr>
<td>Voltage, Current, and Power</td>
<td>If the Voltage, Current, and Power check boxes are selected in Monitoring Setup (p.41), the corresponding load values are displayed.</td>
</tr>
</tbody>
</table>

- **Status indicators**

  - **Standby**: Standing by.
  - **Running**: A sequence is running.
  - **End**: The sequence has finished.
  - **Stop**: The Stop button was clicked.
  - **Error**: Communication error. Check the interface settings.
  - **OVP**: A protection function has been activated.*1 OVP: overvoltage protection, OCP: overcurrent protection, OPP: overpower protection, UVP: undervoltage protection, UCP: undercurrent protection, OHP: overheat protection, WDOG: watchdog protection, REV: reverse-connection detection, EXT: external error, FORM: connection error

*1. You can determine which protection function (hardware or software) was activated with the background color. Orange indicates that a PLZ-5W protection function was activated. Yellow indicates that a Wavy protection function was activated.

**NOTE**: When the monitor graph is displayed (p.42), executing a long sequence will increase the monitor graph data and put a heavy load on the PC. In such situations, you can reduce the load by setting a maximum number of data entries of the monitor graph (p.54).
Configuring the Monitor

You can specify whether to display monitor values and monitor graph in the sequence run window. You can also set the monitoring interval and save monitored data.

Showing or hiding current, voltage, and power values

You can specify whether to display monitored values (current, voltage, power) and in the sequence run window.


2. Under Select Items to be Monitored, select the check boxes for the monitored values you want to display.

3. Click OK. This completes the settings.
Configuring the Monitor

Showing or hiding the monitor graph

You can specify whether to show the monitor graph in the sequence run window. If you show the monitor graph, you can view in real time on graphs the current, voltage, and power values during sequence execution. You can also view the setting graph and the monitor graph in a single window. You can change which graphs (current, voltage, power) to show in the monitor graph (p.41).

1. On the Sequence menu, click Monitoring Setup. Or, click on the toolbar.
   The Monitoring Setup window appears.

2. To display the monitor graph, select the “Display the monitor graph” check box. To not display it, clear the check box.

3. Click OK.
   This completes the settings.

NOTE
When the monitor graph is displayed, executing a long sequence will increase the monitor graph data and put a heavy load on the PC. In such situations, you can reduce the load by setting a maximum number of data entries of the monitor graph (p.54).
Configuring the Monitor

Setting the monitoring interval

You can change the monitoring interval.

1. **On the Sequence menu, click Monitoring Setup. Or, click on the toolbar.**
   The Monitoring Setup window appears.

2. In the Monitoring Interval box, enter the interval (200 ms to 600000 ms).

3. **Click OK.**
   This completes the settings.
Saving monitored data

You can save the monitored data obtained by executing sequences as a text file. Enabling this setting will automatically save monitored values during sequence execution.

1. **On the Sequence menu, click Monitoring Setup. Or, click on the toolbar.**
The Monitoring Setup window appears.

2. **Under Save File, select Yes. Then, specify the save destination.**
The file name consists of the operation mode, the execution start date and time, and the file name extension. You can change the file name extension (the default is .txt) (p.55).

3. **Under Unit of Elapsed Time for Output to File, select the output unit.**

   | [s] (S) | Seconds |
   | [h:min:s] (H) | Hours, minutes, seconds |

   The accuracy of the elapsed time varies depending on the PC environment that you are using.

4. **Under “for Saved Data,” select the check boxes of the options you want to use.**

   - **Data right before Run**
     - The monitored values before sequence execution (monitored values at time 0 s) are written at the beginning of the saved data.

   - **Data Immediately after End/Stop**
     - The monitored values when the sequence is completed or aborted are written at the end of the saved data.

5. **Use the settings under “Order for Output to File” to set the order that time, voltage, current, and power are written to files.**

6. **Click OK.**
This completes the settings.
### Viewing saved data

You can view saved monitored data using Notepad or other text editor.

![Data Table Example](image)

By default, data is saved as tab-separated values. You can also change to comma-separated values (p.55).
For the three types of graphs used in Wavy, specify graph lines, colors, and other graph related settings.

**Graph window**

![Setting graph in the Run window](image1)

![Monitor graph in the Run window](image2)

To display the monitor graph, see “Showing or hiding the monitor graph” (p.42).

The items that you can set vary depending on the graph.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Graph window</th>
<th>Setting Graph</th>
<th>Monitor Graph</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scale</td>
<td>Show or hide X-axis and Y-axis scales, number of scale lines, line types (p.47).</td>
<td>![checkmark]</td>
<td>![checkmark]</td>
<td>![checkmark]</td>
</tr>
<tr>
<td>Color</td>
<td>Line colors and background color (p.48).</td>
<td>![checkmark]</td>
<td>![checkmark]</td>
<td>![checkmark]</td>
</tr>
<tr>
<td>Step Division lines</td>
<td>Show or hide the division lines between steps (p.49).</td>
<td>![checkmark]</td>
<td>![checkmark]</td>
<td>—</td>
</tr>
<tr>
<td>Scale</td>
<td>X-axis and Y-axis scales (p.49).</td>
<td>![checkmark]</td>
<td>—</td>
<td>![checkmark]</td>
</tr>
<tr>
<td>Load line display</td>
<td>Show or hide current, voltage, and power lines (p.51).</td>
<td>—</td>
<td>—</td>
<td>![checkmark]</td>
</tr>
<tr>
<td>Y value display</td>
<td>Value that appears when the mouse pointer is placed on the Y-axis (p.51).</td>
<td>—</td>
<td>—</td>
<td>![checkmark]</td>
</tr>
<tr>
<td>X-axis unit display</td>
<td>Unit of the X-axis (p.52).</td>
<td>—</td>
<td>—</td>
<td>![checkmark]</td>
</tr>
</tbody>
</table>
Setting the Graph Display

For the graphs in the Graph window and setting graph and monitor graph in the sequence run window, you can show or hide the X-axis and Y-axis scales and set the number of scale lines and the line types (dotted or solid).

Showing or hiding the X-axis and Y-axis scales

Right-click the graph, and then click X-axis Scale Lines or Y-axis Scale Lines to show or hide scales. For the Graph window, you can also show or hide the scales by clicking X-axis Scale Lines or Y-axis Scale Lines on the Graph menu.

Number of scale lines and line types

You can set the number of graph scale lines and the type of scale lines (solid or dotted).

Graph window

1. **On the Graph menu, click Scale. Or, click \[ \] on the toolbar.**
   A Scale window appears.
   You can also right-click in the graph, and click Scale to display the Scale window.

2. **Set the number of scale lines and line types.**
   - **Number of scale lines**
     Enter the number of scale lines for the X-axis and Y-axis.
   - **Dot**
     To use dotted scale lines, select the check box. To use solid scale lines, clear the check box.
Setting the Graph Display

■ Setting graph or monitor graph

1 **Right-click the graph, and click Scale lines.**
   A Scale lines window appears.

   ![Scale lines window](image)

2 **Set the number of scale lines and line types.**

<table>
<thead>
<tr>
<th>Number of scale lines</th>
<th>Enter the number of scale lines for the X-axis and Y-axis.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dot</td>
<td>To use dotted scale lines, select the check box. To use solid scale lines, clear the check box.</td>
</tr>
</tbody>
</table>

### Setting line colors and background color

You can change the line colors and background color of the graphs in the Graph window and the setting or monitor graphs in the Run window. The items that you can set vary depending on the graph.

<table>
<thead>
<tr>
<th>Item</th>
<th>Graphs in the Graph window</th>
<th>Setting graph in the Run window</th>
<th>Monitor graph in the Run window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>X/Y-axis</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>XY-axes scale lines</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Vertical Axis</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>Line</td>
<td>✓</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>Line to Draw</td>
<td>✓</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Line to Run</td>
<td>—</td>
<td>✓</td>
<td>—</td>
</tr>
<tr>
<td>Current line</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>Voltage line</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td>Power line</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
</tbody>
</table>

1 **Right-click the graph, select Color, and select the item you want to change.**
   The color setting window appears.
   For the Graph window, you can also display the color setting window by clicking Color on the Graph menu and then selecting the item you want to change.

2 **Select the color, and click OK.**
   This completes the settings.
Showing and hiding the step-division lines (vertical axis)

You can show or hide the division lines (vertical axis) between steps in the graphs in the Graph window and the setting graph in the sequence run window.

Right-click the graph. Each time you click Vertical Axis, the step-division lines are shown or hidden.

For the Graph window, on the Graph menu, click Vertical Axis. Or, click on the toolbar. This will show or hide the step-division lines.

Setting the graph scale

You can set the X-axis and Y-axis scales on the graphs in the Graph window and the monitor graph in the sequence run window.

Graph window

1. **On the Graph menu, click Scale. Or, click on the toolbar.**
   
   A Scale window appears.
   
   You can also right-click in the graph, and click Scale to display the Scale window.
2 If you want the scale to be adjusted automatically according to the monitored values, select the Auto check box of the appropriate items.

Auto scale will be enabled. This feature automatically updates the scale values to the appropriate values when you enter values to set a step or when you open a saved file.

If the check box is not selected, values outside of the setting range are not displayed on the graph.

If you are setting steps by drawing a graph, the scales will not be automatically updated even if the Auto check box is selected. To update the scales, on the Graph menu, click Update Auto Scale, or right-click the Graph window, and click Update Auto Scale.

3 To manually set the scales, enter the X-axis and Y-axis scales.

<table>
<thead>
<tr>
<th>X-axis</th>
<th>Maximum Time</th>
<th>Enter the maximum time to display on the X-axis.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Time</td>
<td>Enter the minimum time to display on the X-axis.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Y-axis</th>
<th>Maximum Value</th>
<th>Enter the maximum value to display on the Y-axis.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum Value</td>
<td>Enter the minimum value to display on the Y-axis.</td>
<td></td>
</tr>
</tbody>
</table>

4 Click OK.

This completes the settings.

Monitor graph in the sequence run window

1 Right-click the graph, and click Scale.

A Scale window appears.

2 If you want the scale to be adjusted automatically according to the monitored values, select the Auto check box of the appropriate items.

Auto scale will be enabled.

If the check box is not selected, monitored values outside of the setting range are not displayed on the graph.
3 If you select the Auto check box of the X-axis, select the graph scroll mode.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roll</td>
<td>The X-axis and Y-axis are scrolled at the same time according to the elapsed time and load values. The display range is defined by subtracting the minimum time value from the maximum time value.</td>
</tr>
<tr>
<td>Normal</td>
<td>The minimum time is fixed. The maximum time is updated to the appropriate value. If you want to scroll only when the monitored value exceeds the maximum X-axis value, select the “Scrolling within the specified range” check box. The amount of time that the graph will be scrolled by is determined by subtracting the minimum time value and the set scroll time from the maximum time value. For example, if the minimum time is set to 0 seconds, the maximum time to 23 seconds, and the scroll time to 10 seconds, the time range that will be scrolled is 13 seconds.</td>
</tr>
</tbody>
</table>

4 To manually set the scales, set the X-axis and Y-axis scales.

<table>
<thead>
<tr>
<th>Axis</th>
<th>Minimum Time</th>
<th>Maximum Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>X-axis</td>
<td>Enter the minimum time to display on the X-axis.</td>
<td>Enter the maximum time to display on the X-axis.</td>
</tr>
<tr>
<td>Y-axis</td>
<td>Enter the minimum value to display on the Y-axis.</td>
<td>Enter the maximum value to display on the Y-axis.</td>
</tr>
</tbody>
</table>

Setting the load line display

You can show or hide current, voltage, and power lines on the monitor graph in the sequence run window.

Right-click the graph, select Line Display, and select the value you want to show. Each time you select, show and hide toggle.

Setting the Y value display

You can set the Y-axis value (current, voltage, or power) that is displayed when the mouse pointer is placed on the Y-axis on the monitor graph in the sequence run window.

Right-click the graph, select Y-Axis Value, and select Current, Voltage, or Power.
Setting the unit of the X-axis

You can change the X-axis (time-axis) unit (√ or h:min:s) of the monitor graph in the sequence run window.

Right-click the monitor graph, click X-axis Unit and select “s” to set the unit to seconds. If you click X-axis Unit and select “h:min:s,” the unit is set to hour:minute:second.
Setting the Window Display

Showing or hiding the toolbar and status bar

Each time you select Toolbar or Status Bar from the View menu, the toolbar or status bar switches between show and hide.

Saving the window position and size

Each time you select Save Position from the View menu, the setting for saving the window position and size switches between on and off.

Arranging windows

You can change the way the Graph and Worksheet windows are displayed.
On the Window menu, click Cascade, Tile Vertically, or Tile Horizontally to change the way that windows are displayed.
Other settings

Reducing the PC load

Executing a long sequence will increase the amount of monitor graph data on the sequence run window. This puts a heavy load on the PC and may cause the PC to malfunction. In such situations, you can reduce the load by setting a maximum number of data entries of the monitor graph.

Even if you set the maximum data size, all monitored data will be saved.

1. **Right-click the monitor graph, and click Max Data Count.**
   The Maximum number of data window appears.

2. **Enter the value (10000 to 1000000; the default value is 100000).**
   If the number of monitored data entries exceeds the set value, monitored data is deleted starting with the oldest entry.
   One monitored data entry uses approximately 200 bytes.

3. **Click OK.**
   This completes the settings.
   When you run a long sequence, we recommend that you use Task Manager to check the amount of physical memory being used.

Setting the number of significant digits of the load value

Set the number of significant decimal digits of the load values (current, conductance, voltage, power) when creating steps. The actual number of significant decimal digits varies depending on the model and range of the PLZ-SW.

1. **On the Sequence menu, click Options.**
   The Options window appears.

2. **Select the number of significant digits.**
   - **Current**: 2 to 5 (x.xx to x.xxxxx)
   - **Conductance**: 4 or 5 (x.xxxx, x.xxxxx)
   - **Voltage**: 2 or 3 (x.xx, x.xxx)
   - **Power**: 2 to 4 (x.xx to x.xxxx)

3. **Click OK.**
   This completes the settings.
Setting the file format for saving data

You can change the file format for saving sequence and monitored data.

1. **On the Sequence menu, click Environment Settings.**
   The Set Environment window appears.

2. **Select the file format.**
   - **Sequence data file format**: Click Tab Separation or Comma Separation*1 to select the file format for saving sequences.
   - **Monitor output data file format**: Click Tab Separation or Comma Separation*1 to select the file format for saving monitored data. Select the extension (txt, csv, log) or enter an extension of your choice.

3. **Click OK.**
   This completes the settings.

Copying graph images to the clipboard

To copy the image of the graphs in the Graph window, click the graph, and on the Graph menu, click Copy.

Setting whether to display the sequence that was showing when Wavy was closed previously

You can set whether to display the sequence that was showing when Wavy was closed previously. Each time you click Previous File on the View menu, show and hide toggle.
You can control the PLZ-5W from Wavy without using sequences. There are two methods. One method (direct control) is to control from the Remote Control Panel window, and the other is to control using commands.

**Controlling the PLZ-5W directly**

The Remote Control Panel window is used to control the PLZ-5W directly.

On the Tool menu, click Direct Control to display the Remote Control Panel window.

1. Enter operating conditions. (p.57)
2. Enter load values. (p.57)
3. Displays execution results.
4. Turn the load on and off, or clear alarms. (p.59)
5. Monitor function. Save monitored values. (p.60)
Entering operating conditions

<table>
<thead>
<tr>
<th>Mode</th>
<th>Select the operation mode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Range</td>
<td>Select the current range. Even during parallel operation, only the master unit’s current range is displayed.</td>
</tr>
<tr>
<td>Voltage Range</td>
<td>Select the voltage range.</td>
</tr>
<tr>
<td>Response CV</td>
<td>Select the response speed in CV mode.</td>
</tr>
<tr>
<td>Response CR</td>
<td>Select the response speed in CR mode.</td>
</tr>
<tr>
<td>Slew Rate</td>
<td>Entering a slew rate and clicking Set will apply the slew rate to the PLZ-5W. To load the slew rate set on the PLZ-5W, click Read.</td>
</tr>
</tbody>
</table>

Entering load values

The values that you set vary depend on the selected operation mode.

If operation mode is set to CC, CR, CV, CP, CC+CV, or CR+CV
Click the tabs of the relevant operation modes, enter the load values and the maximum and minimum load values, and click Set. If you click Up or Down, the load value increases or decreases by the value entered in the Step box.
If operation mode is set to ARB

A setting worksheet and graph for ARB mode are displayed.

Setting worksheet

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Current</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1,000</td>
</tr>
<tr>
<td>2</td>
<td>1,000</td>
</tr>
<tr>
<td>3</td>
<td>3,000</td>
</tr>
<tr>
<td>4</td>
<td>10,000</td>
</tr>
<tr>
<td>5</td>
<td>40,000</td>
</tr>
<tr>
<td>6</td>
<td>40,000</td>
</tr>
</tbody>
</table>

Double-click the voltage and current cells, and enter the load values. You cannot change the voltage and current in the first row or the voltage in the last row. For voltage, you can only enter a value greater than the value of the previous row.

To copy and paste a value, select the cell, right-click, and select Copy and Paste.

You can change the number of rows by clicking Setting, and then entering a value in the Data num box.

Clicking Set will apply the settings entered in the setting worksheet to the PLZ-5W.

Graph

The settings entered in the setting worksheet are shown on a graph. When you move the mouse pointer over the Y-axis or X-axis, the current or voltage is displayed. When you move the mouse pointer over the graph line, the voltage and current settings are displayed.

To set the details of ARB mode, click Setting in the setting worksheet window.

A setting window appears.

<table>
<thead>
<tr>
<th>Data num</th>
<th>Set the number of rows of the setting worksheet (3 to 100).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum voltage, Maximum voltage</td>
<td>The minimum and maximum voltages of ARB mode. You cannot change this value.</td>
</tr>
<tr>
<td>Default current value</td>
<td>Enter the default value for the current column of the setting worksheet.</td>
</tr>
<tr>
<td>Update</td>
<td>Applies the entered settings to the setting worksheet.</td>
</tr>
<tr>
<td>Get</td>
<td>Obtains ARB values from the connected PLZ-5W.</td>
</tr>
<tr>
<td>Save</td>
<td>The settings on the setting worksheet are saved to a text file (IV file, .iv extension). You can edit IV files (p.59).</td>
</tr>
<tr>
<td>Open</td>
<td>Loads an IV file and applies the settings to the setting worksheet.</td>
</tr>
</tbody>
</table>
Editing the saved ARB mode values

You can use a text editor to edit IV files (p.58) saved from the Setting window with the operation mode set to ARB. Edited IV files can be loaded from the Setting window of ARB mode (p.58).

- The file is saved in comma separated format.
- In the first line, the minimum and maximum voltages are displayed. Do not change these values.
- In the following lines, a voltage is displayed first and then a current. Do not change the voltage and current on the second line or the voltage on the last line.

Turning the load on and off or clearing alarms

<table>
<thead>
<tr>
<th>Status</th>
<th>This shows the load on/off status.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON</td>
<td>Turns the load on.</td>
</tr>
<tr>
<td>OFF</td>
<td>Turns the load off.</td>
</tr>
<tr>
<td>Clear</td>
<td>Clears PLZ-5W alarms.</td>
</tr>
</tbody>
</table>
### Using the monitor function and saving monitored values

| Max, Min | Enter the maximum and minimum monitored values. |
| Voltage, Current, Power, Energy | Select the check boxes for the values you want to monitor. The monitored values will be displayed while monitoring is in progress. Clear the check boxes if you do not want to monitor the values. |
| Status | Shows the PLZ-5W status (p.40) while monitoring is in progress. |
| Elapsed Time | Displays the elapsed time since the start of monitoring. |
| Run | Start the monitor. You cannot close the Remote Control Panel window while monitoring is in progress. |
| Stop | Stops the monitor. |
| Interval | Enter the monitoring interval (200 ms to 600000 ms). |
| Save File | Select the check box to save monitored data. Click Folder to select the file save destination, the unit of the elapsed time that will be output, and the order in which values will be output. The file name consists of “Wavy,” the monitor start date and time, and file name extension. You can change the file name extension (the default is .txt) (p.55). |
Using commands to control the PLZ-5W

You can send commands from Wavy to control the PLZ-5W.

1. **On the Tool menu, click Command Control.**
   A Command Control window appears.

2. **Enter a command, and then click Run.**
   The result will be displayed.
   Commands that are successfully sent and received are registered in the list box. You can clear them by clicking Clear.

For details on commands, see the Communication Interface Manual in the CD-ROM included with the PLZ-5W.
## Menu Reference

### File

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New*1</td>
<td>Creates a new file.</td>
</tr>
<tr>
<td>Open*1</td>
<td>Opens an existing file.</td>
</tr>
<tr>
<td>Save*1</td>
<td>Overwrites the file that you are working on.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the file that you are working on with a new name.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the file that you are working on.</td>
</tr>
<tr>
<td>Recent files</td>
<td>Shows up to four paths to the recently opened sequence data files (.wvy extension).</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes Wavy.</td>
</tr>
</tbody>
</table>

### View

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Shows or hides the toolbar.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Shows and hides the status bar.</td>
</tr>
<tr>
<td>Save Position</td>
<td>Selects whether to save the window position and size.</td>
</tr>
<tr>
<td>Previous File</td>
<td>Loads the last file that was used when the software starts.</td>
</tr>
</tbody>
</table>

### Graph

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transition</td>
<td>Changes the selected line to a ramp transition.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected line.</td>
</tr>
<tr>
<td>Vertical Axis*1</td>
<td>Shows and hides the vertical-axis lines (step-division lines).</td>
</tr>
<tr>
<td>X-axis Scale Lines</td>
<td>Shows or hides X-axis scale lines.</td>
</tr>
<tr>
<td>Y-axis Scale Lines</td>
<td>Shows or hides Y-axis scale lines.</td>
</tr>
<tr>
<td>Scale*1</td>
<td>Change the X-axis and Y-axis scale.</td>
</tr>
</tbody>
</table>

### Color

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background</td>
<td>Change the background color of the graph.</td>
</tr>
<tr>
<td>Line</td>
<td>Change the step line color.</td>
</tr>
<tr>
<td>Line to Draw</td>
<td>Change the line color for drawing graphs.</td>
</tr>
<tr>
<td>Vertical Axis</td>
<td>Change the vertical-axis color.</td>
</tr>
<tr>
<td>X/Y-axis</td>
<td>Change the X-axis and Y-axis colors.</td>
</tr>
<tr>
<td>XY-axes scale lines</td>
<td>Change the X-axis and Y-axis scale line colors.</td>
</tr>
</tbody>
</table>

### Time interval resolution

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Set the time interval (X-axis) resolution for drawing graphs. The “Default” is three decimal places.</td>
</tr>
<tr>
<td>1st digit of integer</td>
<td></td>
</tr>
<tr>
<td>1st digit of decimal place</td>
<td></td>
</tr>
<tr>
<td>2nd digit of decimal place</td>
<td></td>
</tr>
</tbody>
</table>

### Setting resolution

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Set the value (Y-axis) resolution for drawing graphs. The “Default” is four decimal places.</td>
</tr>
<tr>
<td>1st digit of integer</td>
<td></td>
</tr>
<tr>
<td>1st digit of decimal place</td>
<td></td>
</tr>
<tr>
<td>2nd digit of decimal place</td>
<td></td>
</tr>
<tr>
<td>3rd digit of decimal place</td>
<td></td>
</tr>
</tbody>
</table>

### Additional Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always draw as steps</td>
<td>Draws graphs using steps regardless of the “Transition” setting.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the graph screen to the clipboard.</td>
</tr>
<tr>
<td>Update Auto Scale</td>
<td>Applies auto scaling to the graph.</td>
</tr>
</tbody>
</table>
## Worksheet
- **Select All**
  - Selects all cells.
- **Undo**
  - Undoes the previous operation.
- **Delete**
  - Deletes step data.
- **Copy**
  - Copies step data.
- **Paste**
  - Inserts step data.

## Sequence
- **Transfer**
  - Reads and writes sequence data.
- **Run**
  - Run the sequence.
- **Sequence Creation Mode**
  - Sets the step interval unit, operation mode, current and voltage ranges, +CV option, and protection function to use during sequence execution.
- **Monitoring Setup**
  - Configure monitor settings used during sequence execution.
- **Protection Setup**
  - Configure the hardware and software protection functions.
- **Interface**
  - Set the conditions for connecting the PC and PLZ-5W.
- **Environment Settings**
  - Set the file format for saving text files.
- **Options**
  - Set the number of significant digits for load values.

## Tool
- **Direct Control**
  - Directly control the PLZ-5W.
- **Command Control**
  - Control the PLZ-5W by entering commands.

## Window
- **Cascade**
  - Displays cascaded windows.
- **Tile Vertically**
  - Displays horizontally tiled windows.
- **Tile Horizontally**
  - Displays vertically tiled windows.

## Help
- **Help Topics**
  - Opens the help file.
- **About Wavy**
  - Shows the program version and copyright information.

---

*1. There is also a toolbar button for this command.*